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Thank you everyone for your feedback on the last issue 

of the MBTS TekJournal.  The main response was that 

the new format is preferred to other formats that have 

been used and the newsletter is easy to print and read. 

The big news lately is there is now a viable alternative 

to Internet Explorer (IE), Firefox.  It allegedly doesn’t 

have the security problems of IE, and also has a brand 

new email client to do battle with Outlook Express.  

See our article on Microsoft Alternatives for more 

information and the latest bug. 

One section which ahs been in almost every 

TekJournal has been Tips and Tweaks.  However, in 

many cases to implement these modifications you will 

have to make changes to the System Registry.  This 

issue deals with proper backup and restore techniques 

for helping to make sure you always have a good copy 

of the System Registry to fall back on. 

I have received many ideas for future articles including 

a request to delve into Word and Excel and help users 

get more familiar with the features of these 

applications.  You also want to know how to backup 

DVD’s, the intricacies of home networking, wireless vs. 

traditional networks, making backups of Outlook and 

Outlook Express, just to name a few.  Even though my 

continued on page 2 

Backing up the System Registry 

In many of our issues we have published enhance-

ments to the Windows Operating System in what is 

called a Tweak.  In order to implement many of these 

Tweaks, you are required to make a change to the 

System Registry.  However, since making a wrong 

move in the System Registry can leave your system 

inoperable, you will always see the following 

disclaimer: 

NOTE – Modifying System Files is not recommended. 

These procedures may contain information regarding 

editing the System Registry.  You should make sure 

you have a valid System Registry backup before 

attempting any of these modifications.  Incorrect editing 

may severely and irreparable damage your operating 

system. MicroByte TekSolutions takes no responsibility 

for the health or stability of your system should you 

attempt to implement any modification found herein. 

Whenever changes are made to the System Registry in 

Windows, even those users with the best intentions can 

make a minor error and end up with a non-functioning 

or unstable system.  The only way to gracefully back 

out of this situation is to be able to restore the System 

Registry with a known clean copy which was obtained 

prior to the change which crippled the system.  This 

article will help you make sure you have a good backup 

copy of the System Registry to fall back on. 

To access the System Registry you will click on start 

and then select Run.  In the dialog box which appears 

you will type in regedit and press OK. 

The System Registry is made of up five distinct regions 

called hives.  Under the heading of My Computer the 

hives are called: 

• HKEY_CLASSES_ROOT 

• HKEY_CURRENT_USER 

• HKEY_LOCAL_MACHINE 

• HKEY_USERS 
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Welcome continued from page 1 

• HKEY_CURRENT_CONFIG 

When the System Registry is opened the first time all 

the hives should be collapsed and all you should see 

are the five labels above under the main heading of 

My Computer.  If any of the hives have been 

expanded, you can safely collapse them by pressing 

on the minus sign beside keys which have been 

expanded. 

To backup the complete System Registry highlight 

My Computer and click on the File Menu and select 

Export.  The dialog box that pops up is called “Export 

Registry File” and defaults to saving the file in the 

users My Documents folder.  If you are saving the 

complete System Registry we suggest a using a 

name like SysReg and the current date. Once you 

have selected a name, click Save to save the file.  

You may also choose to create a special folder for 

Saved Registry keys so you can identify them more 

readily. 

To save a specific key, sub key, hive, or other object, 

navigate to that object and repeat the above process 

for saving the System Registry.  In this instance use 

the name of the key you are saving as the name of 

the file to be created during the save.  This way, if 

you change or delete a key you shouldn’t have, it will 

be easy to find the right one to restore. 

Restoring a Key or group 

When you saved the key or sub key above and gave 

it a file name, the system automatically appended the 

file extension of “.reg” to indicate it as a Registry File.  

To restore the contents of the key that was changed 

in error, navigate to the location where you stored the 

file, the default folder is “My Documents”, and double 

click on the file to wish to restore.  Windows security 

will pop up a dialog box asking if you are sure you 

want to add the contents of this file to the Registry.  

Click Yes to proceed or No to cancel. 

Creating a Restore Point 

Now that we know how to backup and restore all or 

part of the System Registry manually, we can show you 

an alternate method that you may find easier and less 

stressful.  The alternate method can also be used, and 

in many cases may be automatic, when you are going 

to install new programs to your system. This method is 

found under Help and Support and is known as 

creating a Restore Point. 

To see what Restore Points are currently available on 

your system, click start and select the Help and 

Support option.  Select the option labeled “Undo 

changes on your computer with System Restore.”  The 

default option is “Restore my computer to an earlier 

time”: Click Next.  On this screen you will see a 

calendar where some of the dates are listed in Bold.  

These are the dates when a Restore Point was created 

for you.  Clicking on these dates will show what 

changes were made after the Restore Point was 

created.  Now that you have seen what Restore Points 

look like we can close this window with taking any 

action by clicking the X in the top right corner. 

The reason for Restore Points is that if you make a 

change to your system by adding new drivers or 

applications that cause your system to respond 

unexpectedly, you can select a specific point in time 

when you know your system functioned properly and 

hopefully restore it to its’ previous working state. 

To create a Restore Point, open Help and Support and 

select “Restore my computer to an earlier time”.  This is 

another of those Microsoft wonders of click start to 

stop.  Anyway, click the button marked “Create a 

Restore Point” and then click Next command button.  

Enter a description as to why the restore point is being 

created, and click Create.  When it tells you the 

Restore point has been created click Finish. 

To restore your system using an existing Restore Point, 

use the option “Restore my computer to an earlier 

time”: Click Next.  Select the Restore Point to use and 

click the Next command button.  In this option always 

accept the defaults provided by the system and you 

shouldn’t have any problems.₪ 

 

 

idea bin is starting to fill, I still need you to send along 

more topics for discussion. 

As for me, my knee surgery went very well and I am 

walking a lot better now than before.  Thank you to 

everyone for their kind wishes during my recovery.₪ 

Backup continued from page 1 
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Microsoft Alternative 
Browsers  

 

Microsoft is certain it has a lock on the computer 

software market since the majority of personal 

computers are running one form or another of its’ 

varied operating system base.  Even though they 

have been discontinued for a long time, some users 

still have and rely on DOS (believe it or not), 

Windows 3.1, Windows 95.  Quite a few users are 

hanging on to Windows 98 (SE), Millennium, and NT.  

The rest of us are using Windows 2000, XP, or XP 

Media Centre, and a few are even using a beta 

version of Windows 64.  However, until recently 

better than 90 percent were probably using Internet 

Explorer and Outlook Express for browsing and 

email.  But that may change quickly and only you can 

be the judge. 

If you surf over to http://www.mozilla.org you will find 

a new robust offering to replace the inherently bug 

ridden Internet Explorer and Outlook Express.  To be 

fair, these tools are only bug ridden because they 

have been around a long time and it seems 

everybody uses them.  That makes them the most 

visible target.  Given time, the offerings from Mozilla 

could take their place, but right now Firefox (browser) 

and Thunderbird (email) seem bulletproof. 

Table 1 (page 4) shows a quick comparison between 

Firefox and Internet Explorer.  Firefox seems to be 

the clear winner and has thrown down the gauntlet.  

Will Microsoft pick it up and issue a similar product.  

Only time will tell (and the number of defectors to this 

new offering). 

Personally, I have quite enjoyed getting to know 

Firefox and have changed both Firefox and IE to stop 

asking if they can be the default browser.  I would like 

to be able to choose which one I want by clicking an 

icon.  After all, if I have Word and Word Perfect 

installed on the same system they don’t ask if they 

can be the default word processor every time they 

start. 

So far I have modified the Bookmark Toolbar to list 

my suppliers for really easy access and have 

extensively used the tabbed window interface to 

compare monitors and other components for a recent 

system.  I feel I was able to comparison shop 

between manufactures considerably faster than with IE 

and multiple windows open on the task bar. 

I have also utilized themes to change the default visual 

appearance of the menu bars and quite like saferfox 

xpanded v2.3.1. 

I definitely think this product is worthy of a month long 

test drive. 

Email 

Most Windows operating systems have come with an 

email client called Outlook Express which quite simply 

is the minute subset of Microsoft Outlook that is used to 

get and send email and not much else.  It is limited to 

one email account and depends on an Identity 

Manager to allow for multiple accounts which means to 

get all your email you must keep switching Identities.  

For that reason alone many people use the full feature 

version of Outlook, but have to buy Microsoft Office to 

get it. 

There is a new email client available from Mozilla 

called Thunderbird which is more Outlook like, but is 

squaring off directly against Outlook Express.  Features 

available in Thunderbird which surpass the features in 

Outlook Express include multiple email accounts in a 

common inbox, junk mail filtering, customizable views, 

and an RSS feed. 

Regarding SPAM (or junk mail) Thunderbird will initially 

identify suspect email with a junk icon, but you can 

train the program to recognize and deal with SPAM 

effectively and quickly.  Once you have trained 

Thunderbird to effectively identify junk mail, it will be 

processed into a special junk mail folder automatically.  

You also have the option of immediately deleting email 

identified as Junk, instead of simply moving it to a junk 

mail folder.  If you move it to a folder, you can set a 

time limit that will automatically delete junk mail which 

is older than x number of days. 

As with Firefox, there are many different themes 

available to customize and personalize your copy of 

Thunderbird, but installing them is a little trickier.  Refer 

to the instructions on each web page as to the proper 

steps, but don’t be surprised if they don’t all work as 

expected.  It took me about three tries but I finally 

installed Nautipolis which adds colour and eye catching 

continued on page 4 
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Mozilla Firefox Microsoft Internet Explorer 

  

No security problems YET! Security problems which are regularly plugged by 

Microsoft Update yet never seem to go away 

Tabbed windows for easier surfing Open windows appear on the Windows Task bar 

Seems to load pages faster than other browsers Quick response, possibly due to cached pages 

Cleanup available via Clean  MOCache @ 

www.buttuglysoftware.com  

Cleanup available via Clean Cache @ 

www.buttuglysoftware.com 

Fully customizable toolbars Fully customizable existing toolbars 

Bookmark Toolbar is standard, customizable, used for most 

often visited sites, can stay visible at all times 

No option available in IE 

Google, Yahoo, Amazon, eBay, Dictionary.com are standard 

search engines 

Default search engine is MSN  

Additional search engines can be added No additional search engines unless primary is replaced by 

a third party product like Copernic (www.copernic.com)  

Primary Menu bar adds Go option to Go directly to recently 

visited sites 

Firefox Go Option sort of available from drop down 

address bar history 

Links from third party programs not yet implemented –

hopefully soon  

Links from third party programs like Norton and Epson 

available now 

Visual presentation is changeable downloadable themes 

(Tools Menu) 

Doesn’t appear to be available in the online Help 

Extensions (Tools menu) expand current capabilities Doesn’t appear to be available in the online Help 

Online help – quite extensive Online Help – quite extensive.  Includes Tip of the Day 

Table 1 

icons to the menu bars. 

The two main features that separate Thunderbird 

from Outlook Express is Junk Mail Filtering and Spell 

checking.  These two alone make the choice of with 

email client to use quite easy.  But if you have 

Outlook 2003, you already have the best available. 

Special Note: 

As of this writing the first magazine published “bug” 

has been reported for Firefox.   The reported 

vulnerability “may let hackers misrepresent the 

source URL of a download.”  While this risk is 

classed as a low level security risk, it can help scam 

artists trick users into downloading malicious 

software. 

The launch of Firefox 1.0 was November 2004, and 

while originally heralded as the “bug free” Internet 

browser, it seems that no software can be labeled 

“bug free”. 

There is a bug reporting site available from Firefox to 

let users identify the weaknesses of the product.  You 

can find the complete list of user reported bugs: 

http://www.mozilla.org/support/firefox/bugs#duplicate

s  

₪ 

 

Microsoft continued from page 3 

MBTS TekSpecial 

MicroByte TekSolutions generally does not offer used 

equipment for sale.  Periodically however, we will 

refurbish a system with new components and resell it 

with an end user warranty.  The following is such a 

system. 

• Raidmax Mid Tower case with 420watt 

power supply and thermal controlled fans 

• ASRock K7S41GX Motherboard with 

integrated 5.1 Channel Audio, Video, & LAN 

• AMD Athlon XP 2100+ (1.73 GHz)  

processor, with 256MB DDR RAM 

• 1.44 MB Floppy drive, 52x24x52x CD RW 

Optical Drive, 80GB 7200rpm IDE Hard Drive 

• Microsoft Wireless Desktop Multimedia 

Keyboard and Optical Mouse 

• Windows XP Professional, Norton Anti Virus 

2005, Desktop Speakers 

• Delivery, Installation & 6 month on site 

warranty 

$ 699.00 

(PST & GST extra) 
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F1 – HELP 

While future issues will deal specifically with Word 

and Excel applications and how to use features 

within each, I thought it would be a good idea to get 

everyone up to speed with online Help as it is 

available in Windows Applications. 

It used to be, and in a few cases is still true, that 

application software came with a user manual.  It was 

usually used to prop up the bad leg of the derelict 

table in the corner of your office, or could be found in 

the bottom drawer of the filing cabinet under the 

lunch bag you thought was lost forever.  In short, it 

was the one book that was generally never read, 

even though the author spent a great deal of time 

writing it. 

I know from experience, since I once wrote appli-

cation software and user manuals for a living. In one 

very memorable manual I put a prize on one of the 

pages offering the first reader to report it the full 

value of the software back.  It took over two years 

from the release of the application before I actually 

had to pay out.  But at least I knew that one user out 

of one hundred or so actually read the book.  Today 

is no different, but Help is much closer than the book 

under your desk. 

Every PC spawned in the IBM led revolution for 

personal computers has a row of programmable keys 

across the top labeled F1 through F10 or F12.  While 

the use of many of these keys has changed over the 

last 25 years, the F1 key has always been reserved 

for HELP.  Hence, the future name of this column will 

be called F1. 

No matter what application you are in, press the F1 

key and a window will pop up that really is there to 

help you.  The Windows operating system is really 

just an application too.  While the desktop is 

displayed, press F1 – up pops the home page for 

Help & Support.  Here you can ask anything of 

Windows and probably get an answer which will help 

you.  Bear in mind the questions you ask must be 

pertinent to the application you are using.  Having 

said that, I just asked Word, “What is a ham 

sandwich?” and it attempted to answer by providing a 

very long list of possible responses.  Unfortunately, 

none of these seem to relate to a ham sandwich but 

at least the Help system tried to point me in the right 

direction.  It may not always understand what you 

want, but it will always try to respond. 

Years ago, help systems were not intuitive.  You had 

to know what you needed help with in order to get it. 

Mail Merge would more likely return a definition than 

real help, but today it returns pointers to dozens of 

articles on How to send letters with ease, resume a 

mail merger, how to use data sources, trouble-

shooting, use it to print letters or do mass e-mailings, 

etc. 

Even though Help has dramatically evolved through 

the last 25 years into a very intuitive on line 

encyclopedia, users are still afraid they will ask the 

wrong question.   

RULE NUMBER ONE: There is no bad question!  If 

you have a question, and you don’t have an answer, 

you have a very good starting point. 

RULE NUMBER TWO: There is no such thing as a 

dumb question.  A computer cannot humiliate you, or 

laugh at you, or snicker at your question. 

Phrasing the question you want an answer to may 

take a little time, but don’t give up hope.  Help 

systems are written by people just like you and me, 

and they really are there to help you.  For example, 

you may want help in Word with lists of things that 

have those little balls or stars beside them, but at first 

don’t seem to be able to think of them as bullets.  I 

tried “information lists” and got a lot of hits but not 

what I wanted, so I tried again and asked for “format 

lists”.  The second response offered “Restore a 

customized list format to its original setting” from the 

Help > Bulleted and Numbered Lists section. Many 

more of the responses were for Bullets and 

numbering so then I asked for help on Bullets, and I 

had more help than I knew what to do with. 

You may not be successful on your first attempt, but 

here perseverance always pays off big time.  It 

doesn’t matter which application you use, the Help 

system will work virtually, if not identically, in every 

application.  That is the beauty of the Windows 

environment. 

Next issue we will begin work with an Excel 

spreadsheet to keep track of mileage for income tax 

purposes. ₪ 
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 Tips & Tweaks 

Backing up Outlook Express 

Probably the most widely used programs for email 

are Microsoft Outlook and Microsoft Outlook Express.  

In each of these applications, we get and send our 

electronic mail, and some of us even use them as a 

giant filing cabinet to save the email we receive.  We 

create additional folders to categorize our stuff and 

we would be lost if we ever lost these precious 

emails. But I would estimate that less than 5 percent 

of all users actually backup their email folders on a 

regular basis.  Some don’t even have a clue as to 

where these files are stored.  In this issue we will 

show you where they are stored and provide you with 

a simple method of backing them up. 

Outlook Express 

Windows XP has made it easier to find the Outlook 

Express files, but they still reside in a hidden folder, 

so a small change must be made to Windows 

Explorer in order to “see” where they are.  Open 

Windows Explorer, click on the Tools menu at the top 

of the page and select Folder Options.  Next click on 

the View tab and under the Files and Folders section 

you will see a file folder labeled Hidden Files and 

Folders.  The default option in Windows is to “Hide” 

this information.  But we want to see it, so use your 

mouse to point to the Radio Button beside “Show 

hidden files and folders” and click once to move the 

dot into that circle.  Another step you may want to 

take is to remove the check mark in the box that says 

“Hide extensions for known file types” so that you can 

see what the file extensions of the various files are. 

Once you have made these changes, click Apply and 

then OK to apply the changes and close the dialog 

box. 

Locating the Outlook Express Files 

To begin the search for your Outlook Express files, 

expand (click the plus sign beside) My Computer, 

then the C: drive, and finally Documents and 

Settings.  Next locate your user profile and expand 

that folder as well. 

The Outlook Express files can be found within the 

Local Settings folder by following the path through 

Microsoft and Identities.  Each Identity used for 

Outlook Express is labeled with a specific key similar 

to the following identifier.  {775FA827-5EEF-4B27-

8B59-D08FC3F98582}. Expanding each of these 

folders will take you to the list of files that make up 

your folders within Outlook Express that hold your 

saved emails. 

Backing it up 

The easiest way to back up your email is to right click 

on the “Identities” folder and drag it to your “My 

Documents” folder.  When you let go of the mouse 

you will be prompted with a context menu offering 

Move here, Copy here, or Create a shortcut here.  

You want to choose the option to Copy Here.  Every 

time you want to make another backup of what is in 

your Outlook Express, follow these instructions, but 

when you tell the system to Copy the files you will 

receive a warning that the folder already exists.  

Then you will tell the system to copy over the existing 

folder and replace the contents with the new 

information. 

Now when you use a recordable device to backup 

the My Documents folder, all your email (as of the 

last backup) will be backed up as well. 

The Windows Address Book 

The Windows Address Book is identified with a file 

that has a “.wab” file extension, and it is not stored in 

the same location as the Outlook Express email files. 

Once again you will have to open Windows Explorer 

and search for this file.  If you have removed the 

check mark to “Hide extensions for known file types” 

you will be able to do a search on the Documents 

and Settings folder for all files which have a wab 

extension.  Since you may not know what the file is 

actually called, you can do a search for a file called 

*.wab which tells the system to report on any file 

which has an extension of wab. 

Once you have found the file with the search you can 

copy it to you’re my Documents folder using the 

same method as used in copying the Identities folder 

above. 

Generally the Windows Address Book file can be 

found under each user name in Documents and 

Settings, Application Data, Microsoft, Address Book. 

Once you have copied the address book file to My 

Documents, your optical backup will contain your 

address book as well.  Now all you have to do is 

remember to back backups using your RW drive.₪ 


